
Customizing 
Mac OS X

M
ac users have always been a creative
bunch. One way that creativity
manifests itself is in the way we like
to customize our computers.
Nearly every aspect of Mac OS X

can be adjusted, enhanced, or otherwise tweaked to suit
your personality and your individual style of working.
Some modifications are just for fun, while others can
boost your productivity, save you time, and make your
Mac a genuine partner in your work.

The techniques covered in this chapter all involve
some sort of customization. Whether it’s sprucing up
your toolbars with additional icons, turning your desk-
top into an animated aquarium, or bringing back your
favorite interface features from Mac OS 9, the next sev-
eral techniques can help you to make your Mac truly
personal. Some of the techniques even contradict each
other a bit (“Add more icons to your Dock! No, wait —
remove them all!”), but that reflects the delightful real-
ity that we all “think different.” Choose the techniques
that best fit your needs and interests.

 3
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PUTTING MORE “TOOL” IN 
YOUR TOOLBARS

A
ll Finder windows have an area at the top known as the tool-
bar, as shown in Figure 10.1. Along with the Dock, this is
one of the most striking changes from Mac OS 9’s Finder
appearance. And like the Dock, it is highly customizable,
though its power is rarely exploited. In this technique, you

see just how valuable toolbars can be.
You must first understand a couple of basics. First, every Finder window

has the same toolbar — changes you make to one affect all of them. Second,
you can selectively hide or show the toolbar for each window. To toggle
toolbars on or off, you can either click the little pill-shaped button on the
right side of the window’s title bar or choose Hide Toolbar or Show
Toolbar (as appropriate) from the View menu.

Toolbar buttons require only one click to use, just like icons in the Dock
(and unlike the rest of the Finder). A single click on the Home button, for
example, displays the contents of your home folder. You can also use drag-
and-drop on toolbar buttons, so dragging a file onto the Home button on



. .

TECHNIQUE 10

Every Finder window con-

tains a customizable area

called the toolbar, which can

give you quick access to nav-

igation, searching, and file

management tools. Toolbars

are most effective when 

personalized to meet your

needs.

A B O U T  T H E  F E AT U R E
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to access them, this button might be superfluous.
To remove it, hold down the Ô key and drag the
button off the toolbar.
■ Consider removing the View selector. Although
you may change window views frequently, it’s very
easy to do by using menu commands on the View
menu (or their keyboard equivalents). The extra
space might come in handy; if you think so, you
can Ô+drag off the View selector as well.
■ Pay attention to the buttons you use regularly.
The Computer, Home, and Applications buttons
are more a matter of personal work habits. By
using the other techniques in this chapter and the
next one, I’ve found that I rarely need to open any
of those folders — and when I do, several other
quick shortcuts can do the trick. However, your
mileage may vary. If you don’t use a given button
at least a few times a week, consider removing it.
You’ll be glad for the extra space shortly.

STEP 2: ADD TOOLS FROM APPLE’S 
COLLECTION

Now that you’ve cleared some space, fill it up with
buttons that might be a bit more useful. Although
you can add any icon on your computer to a toolbar,
Apple supplies some special buttons that you might
want to start with. To display them, right-click (or
Control+click) on any part of the toolbar and choose
Customize Toolbar from the contextual menu. The
window changes (Figure 10.4) to reveal a wide vari-
ety of buttons from which you can choose.

 Chapter 3 Customizing Mac OS X

your toolbar moves it to your home folder. Likewise,
dragging a file to an application icon on your toolbar
opens the file in that application.

STEP 1: REMOVE TOOLS YOU NEVER USE

The first step in having a useful toolbar is to get rid of
all icons you don’t use. By default, Finder toolbars
display, from left to right, Back and Forward buttons,
a View selector, a divider; then buttons for your
Computer, Home, Favorites, and Applications fold-
ers, respectively; and finally a Search box. (If your
window is too narrow to display them all, click the
chevron (») icon to display a pop-up menu with the
remaining choices, as shown in Figure 10.3.) You can
remove or rearrange all these elements — and, of
course, you can easily restore them if you change
your mind.

■ Decide whether to eliminate the heart-shaped
Favorites button. Because you have lots of places
to keep aliases to favorite files and other easy ways

.

Toolbars make the most sense with relatively

wide windows because the icons don’t shrink like

those in the Dock do.You might find that Column

View, which also works best with wide windows,

is a good partner for your new toolbars.

T I P

Whatever else you do, I recommend leaving the

Back and Forward buttons and the Search box.

They come in handy in other techniques.

T I P
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■ To add a button, simply drag it to the toolbar.
You can arrange buttons in any order, and you can
also drag to rearrange ones already there. The first
item from this group you might consider is the
Path control. Displaying your current folder’s loca-
tion within the file system has always been possible
by Ô+clicking the window title (Figure 10.5). This
control does exactly the same thing, but without
requiring you to use your other hand to hold
down an extra key (Figure 10.6).

Beyond that, it’s again a matter of which but-
tons, if any, appeal to your needs and style of
working. I suggest, though, that you bypass the
Delete button. As the name suggests, clicking this
button deletes any selected files (by moving them
to the Trash). However, doing this requires two
clicks (select the file, then click the button). In a

Putting More “Tool” in Your Toolbars 

moment, I’ll show you how you can add a Trash
icon to your toolbar to delete files with a single
click-and-drag.
■ When you’re finished making changes, click
Done to return your window to its normal state.

STEP 3: ADD YOUR OWN TOOLS

It’s time to get creative and select icons of your own
to add to the toolbar. These should be folders, files, or
applications you want to use frequently. How do you
decide which icons should go in the toolbar and
which should go in the Dock? There’s no magic for-
mula (and no reason icons can’t go both places). As a
general rule, though, it makes the most sense for the
icons in a Finder toolbar to be ones that open specific
folders or act on files, whereas the Dock is a better
place for applications (and folders or volumes you
want to navigate quickly without opening any new
windows). Figure 10.7 shows a toolbar with the fol-
lowing useful icons added:

■ Desktop (displays the contents of your desktop
folder)
■ Documents (displays the contents of your
Documents folder)
■ StuffIt Expander (expands any file using drag-
and-drop)

.

.

Ô+click file name in title bar

.

Click Path menu in toolbar

.
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press Ô+C to copy it. Switch to the Info window
for your new alias, click the folder icon to select it,
and press Ô+V to paste. Your alias should now
look like the Trash (albeit with an arrow in the
corner). You can close both Info windows.
■ Last but not least, move it to a location where
you won’t accidentally delete it — perhaps your
Documents folder. (If you miss having a Trash
icon on your desktop, you can, of course, keep it
there.)
■ Now drag your new alias to the toolbar and
you’re done! Figure 10.9 shows the final product.
To use the toolbar Trash icon, drag files into it just
as you would to the Dock’s Trash. You’ll notice
that your toolbar Trash icon does not change to
show that it has files in it, and even the real Trash
icon in the Dock might not reflect the change
until you click it. In addition, you cannot use this
icon to eject removable media. But for deleting
files quickly, you’ll find that dragging them a short
distance onto the toolbar rather than all the way to
the Dock is generally quicker and easier.

STEP 5: CHANGE THE DISPLAY MODE
(OPTIONAL)

As you add icons to your toolbar, you may find it gets
very crowded. You have three options for adjusting
the display of your toolbar, and you can choose
whichever one makes the most sense to you. The
three options (Icon & Text Mode, Icon Only Mode,
and Text Only Mode) are shown in Figure 10.10.

■ If your Customize Toolbar sheet is open, you
can change modes by choosing the one you want
from the Show pop-up menu in the lower-left
corner.

 Chapter 3 Customizing Mac OS X

STEP 4: ADD THE TRASH TO YOUR
TOOLBAR

If the Delete button that Apple provides as a built-in
toolbar option doesn’t quite cut it for you, put a
Trash icon in your toolbar for conventional drag-
and-drop file deletion. Here’s how:

■ Select any folder on your hard drive (or create a
new one). Make an alias to this folder by pressing
Ô+L. Name this new alias Trash.
■ With the Trash alias selected, choose Get Info
from the File menu. Click Select New Original.
■ When the Open sheet appears, type
~/.Trash and press Return. You’ll notice that a
folder called .Trash is highlighted, even though
it’s dimmed as being unavailable, as shown in
Figure 10.8. Click Choose to reassign your new
alias to the Trash. (Leave the Info window open
for now.)
■ You now have a folder alias pointing to the
Trash, but it doesn’t look like the Trash. To solve
that, click the Trash icon in your Dock to open the
Trash window. With no files selected, choose Get
Info from the File menu to display the Trash info.
Now click the icon in the Trash’s Info window and

. .
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■ If your Customize Toolbar sheet is closed, the
quickest way to change modes is to right-click (or
Control+click) on the toolbar and make your
selection from the contextual menu that appears.

STEP 6: USE TOOLBAR SCRIPTS

AppleScript is Apple’s easy-to-learn scripting lan-
guage. Using tools such as Script Editor or the more
powerful AppleScript Studio (included with the
Developer Tools you installed in Technique 3), any-
one can create powerful programs without having to
study a complex, low-level language. AppleScript is
ideal for manipulating files and folders in the Finder,
and an AppleScript application can, like other appli-
cations, appear in your toolbar. Apple (and some
third parties) have designed a number of AppleScripts,
known as toolbar scripts, that are specially suited for
use in toolbars. You are not going to learn AppleScript
here. Instead, you find out where to find toolbar scripts
other people have created and use them on your own
toolbars.

■ The first place to look is on Apple’s Web site.
Go to www.apple.com/applescript/
toolbar/, where Apple has posted a large 
selection of scripts you can download, along 
with directions for using them.
■ After you’ve downloaded a script and stored it
somewhere safe (like your Documents folder),
drag it onto a toolbar to install it. Figure 10.11
shows a toolbar with a few of these scripts added.

Putting More “Tool” in Your Toolbars 

■ Some scripts are designed to function as a
droplet (drag and drop a file onto it to process
that file), and some are designed as applets (just
click it and it will act on the entire contents of the
window, or on selected files). Some can work
either way. Read the instructions for each script to
determine how it is intended to be used.
■ One of my favorite toolbar scripts is Rotate
Image(s), which changes the orientation of
pictures from my digital camera right in the
Finder — without opening Photoshop or even
iPhoto. (This feature is especially effective in com-
bination with Column View’s Preview column.)
■ Another favorite script comes not from Apple
but from a developer named Marc Linyage. His
Open Terminal Here toolbar script (available 
free at www.entropy.ch/software/
applescript/welcome.html) is shown 
in Figure 10.12. One click, and a new Terminal
window opens, with its working directory already
changed to the current folder.
■ To find more toolbar scripts, visit www.
versiontracker.com. Click the Mac OS X
tab and search for “toolbar script.”

.

.

.
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ENHANCING THE LOOK AND 
FUNCTIONALITY OF YOUR WINDOWS

M
ac OS X provides plenty of options for customizing
your windows. Not only can customization make
your Mac a lot more fun and interesting to look at, it
gives you visual cues that help you locate particular
windows and icons quickly.

Before you get to the technique, you should be aware of a sometimes 
confusing aspect of the Aqua interface: Windows and folders are two very
different things. Using the words window and folder interchangeably is
tempting (and I sometimes do). After all, every time you open a folder it
shows up in its own window, right? Well, sort of — but in Mac OS X, you
can have several windows open at the same time that display the contents
of the same folder, and all of those windows can have different sizes, views,
and other attributes. In addition, every time you press Ô+N, you open a
new window — but without opening any particular folder. So what are you
really customizing here, folders or windows? And how can you tell which
attributes will be saved when?



. .

TECHNIQUE 11

Finder windows are both

beautiful and functional

with their array of Aqua con-

trols and high-tech drop

shadows. By taking a few

extra steps, you can make

them downright fun — and

even more useful.

A B O U T  T H E  F E AT U R E
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privy to? Not at all. You, too, can customize the living
daylights out of any window. Apart from the fact that
it’s a fun way to impress your Windows-using friends,
customizing window backgrounds can be useful. If
you have lots of windows open at once, picking out
the one you’re looking for is easy if it has a distinctive
appearance. To customize a Finder window, do the
following:

■ First, prepare a graphic to be used for the back-
ground. This can be a photo from your iPhoto
collection, a PDF file, a JPEG downloaded from
the Web, or a drawing you created from scratch.
There’s just one catch: You need to make it the
correct size for your window. When you place a
graphic on your window background, it is not
resized or scaled. A picture from your digital cam-
era that’s 1600 × 1200 pixels, for example, would
show only a small corner when placed in a win-
dow. If you’re starting with a large photo, use your
favorite graphics program (GraphicConverter,
Photoshop Elements, or whatever you have
handy) to resize your image to dimensions that
will fit comfortably in a modestly sized window —
try 300 × 400 pixels as a first pass.
■ Open the folder you want to customize. Be sure
the window is in Icon View; background graphics
can’t be used in List View or Column View. The
shortcut to activate Icon View is Ô+1.
■ Press Ô+J (or choose Show View Options
from the View menu) to display View Options.
A floating window like the one in Figure 11.4
appears.
■ Make sure This window only is selected at the
top if you don’t want this picture to appear on the
background of every single window. Click the
Picture radio button at the very bottom of the
window and then click Select and navigate to the
graphic you prepared. After selecting the graphic,
click Select. Your graphic will automagically be
placed on the background of your window, as in
Figure 11.5.

 Chapter 3 Customizing Mac OS X

What you’re actually customizing is the window
attributes that are used by particular folders. If you
open a folder, change the attributes of the window
that appears, and then close the window, those attrib-
utes will be saved in that folder. The next time you
open that folder, it displays in the same size, location,
view, and so on as when you last saw it. If you have
just one window open in the Finder, make changes to
it, and close it, those settings will be used every time
you open a new Finder window.

If you want to be sure the changes you make to a
window affect only one folder, make sure it’s not the
only folder with an open window when you modify
and close it. Conversely, if you really do want to
change the attributes of all new windows, make sure
the window you’re modifying is the only one open at
the time.

STEP 1: ADD A FOLDER BACKGROUND

Have you ever downloaded a piece of software, dou-
ble-clicked the disk image, and seen something like
Figure 11.3? It looks like a window, but not like any
window on your computer. How did it get that way?
Is this some black art that only Mac developers are

.
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■ Using the resize box in the lower-right corner of
the window, resize the window so that the edges of
the graphic are just covered.
■ If your graphic is too large or too small, resize 
it in your graphics application and repeat the pre-
ceding procedure.
■ If you don’t have any appropriate pictures handy,
you can still spruce up your windows by adding a
solid color background. In the View Options win-
dow, click Color instead of Picture and use the
color picker to select your favorite color.

STEP 2: USE CUSTOM ICONS

You can give any file or folder a unique, custom icon.
As with window backgrounds, this can be more than
decoration — it can help you easily pick out impor-
tant folders in a window full of plain blue icons.

Enhancing the Look and Functionality of Your Windows 

Custom icons are especially useful if you add multi-
ple folder or volume icons to your Dock or toolbars.

Custom icons are easy to find. Sites such as 
www.xicons.com and www.iconfactory.com
each have thousands of high-quality Mac OS X icons
you can download for free.

■ Download the packages you’re interested in and
unstuff them.
■ Select a file that has an icon you want to use.
Press Ô+I (or choose Get Info from the File menu).
■ Click the icon in the Info window to select it
and press Ô+C to copy it. Close the Info window.
■ Now select the file or folder you want to use
your new icon on. Once again, press Ô+I to 
display the Info window. Select the icon and 
press Ô+V to paste your new icon over it. This 
is illustrated in Figure 11.6.

.

.

.
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STEP 3: CUSTOMIZE ICON VIEW 
WINDOW LAYOUT

The View Options window has some additional con-
trols for customizing your window display that I
haven’t mentioned yet. The options available vary
depending on which view is active. First, you’ll cus-
tomize options for a window in Icon View (because
that’s what you’ve just been working with); then look
at List View. Most of the layout options are self-
explanatory, so I’ll just mention them briefly.

■ With the folder of your choice open and in Icon
View, choose Show View Options from the View
menu. Make sure the radio button next to This
window only is selected at the top.
■ Change the size of the icons in this window
from mini to maxi (or anywhere in between) by
moving the Icon size slider.
■ Choose a larger or smaller font for filenames,
if you want, from the Text size pop-up menu.
■ If you prefer the filename to appear on the
right, rather than underneath the icons, click the
Right radio button beneath Label position.
Figure 11.8 shows a window with extra-large
icons, a large font, and filename displayed on the
right.
■ Check Snap to grid to keep all your icons neatly
aligned on an invisible grid.

 Chapter 3 Customizing Mac OS X

■ If you ever want to remove your custom icon
and revert to the default icon, just select the icon
in the Info window and press Delete.

Although custom-designed icons often look best, you
can use any graphic on your hard drive — including
PDF files — as an icon. If you have a favorite photo-
graph, drawing, or even a tax form you want to turn
into an icon, it’s easy.

■ Open the file you want to use in Preview. (If it’s
a multi-page PDF, select the page you want to use
in the Thumbnail view on the right.) Press Ô+C
to copy the graphic.
■ Select the icon in the Info window of the file or
folder you want to customize and press Ô+V to
paste.
■ All your graphics files can also have instant cus-
tom icons. In any folder containing graphics files,
choose Show View Options from the View menu.
Click the Show icon preview checkbox, and each
graphic icon in that folder turns into a miniature
version of the entire image. See Figure 11.7 for an
example.

.

You can use all the View customizations you’ve

just tried on the desktop, too. Just click any-

where on your desktop, choose Show View

Options from the View menu, and go to town.

T I P
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■ If you check Show item info, an additional line
of text will appear below the names of certain files,
as shown in Figure 11.9. Folders, for example, will
show the number of items they contain, graphics
(of certain types) will show their dimensions in
pixels, and audio files will display their length.

Enhancing the Look and Functionality of Your Windows 

■ Finally, if you want your icons to organize
themselves even when files are added or removed
from the window, check Keep arranged by and
choose Name, Date Modified, Date Created, Size,
or Kind.

STEP 4: CUSTOMIZE LIST VIEW 
WINDOW LAYOUT

For windows in List View, you have some different
options, as shown in Figure 11.10.

.

. .
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■ Finally, you can arrange columns. The only
restriction is that the Name column must come
first. If you would rather see the Kind column, for
example, before the Size, you can easily do so.
Click and hold the mouse button on a column
heading, and when it changes to a “grabbing
hand” shape, drag the column left or right to
reposition it.

Figure 11.11 shows a window in List View with 
customized columns and icon size. For even more
ways to customize your windows, see Technique 17,
“Restoring ‘Missing’ Classic Features to Mac OS X.”

 Chapter 3 Customizing Mac OS X

■ Choose a larger size for List View icons, if you
want, by clicking the radio button beneath the
larger icon.
■ You can choose which columns are shown for
this window by checking the checkboxes next to
the attributes you want to see. Of particular inter-
est may be Comments. Displaying the Comments
column in List View is the only way to see com-
ments you’ve entered about files without opening
the Info window.
■ Every column header in List View is also a but-
ton that you can use to sort the window contents
by that attribute. For example, click the Date
Modified column header to sort files by date; click
the Name header to sort by name. Clicking any
header a second time reverses the sort order.
■ You can also resize columns in List View to
show more or less information. Position your
pointer on the dividing line between two columns,
and its shape will change to a vertical line with a
pair of arrows. Click and drag left or right to
change the column width. .
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AUTOMATING THE FINDER WITH 
SCRIPTS AND FOLDER ACTIONS

I
f you read Technique 10, “Putting More ‘Tool’ in Your Toolbars,”
you’re already familiar with the idea of using AppleScript applica-
tions to add capabilities to your Finder windows. In this tech-
nique, you again use AppleScripts in the Finder, but in two
different ways. First, you add a menu to the Finder toolbar to pro-

vide single-click access to your favorite scripts. Then you explore a super-
cool (and little-used) Mac OS X feature called folder actions.

You can do everything in this technique without knowing any
AppleScript at all. However, if you want to take these concepts further,
you’ll need to learn some AppleScript programming.



. .

TECHNIQUE 12

AppleScript provides a con-

venient way to automate

repetitive tasks without

learning a lot of program-

ming. Mac OS X includes 

two hidden features — the

Script menu and folder

actions — that make scripts

even easier to use.

A B O U T  T H E  F E AT U R E
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You will use a few other scripts in a moment.
Remember, AppleScripts are just mini-programs.

An AppleScript may not have windows or controls of
its own (though many do). Because AppleScripts are
so varied, the best way to find out what a given script
does is to try it out.

 Chapter 3 Customizing Mac OS X

STEP 1: INSTALL SCRIPT MENU

Apple included a system-wide menu for AppleScripts
in Mac OS X. However, probably thinking it would be
confusing to beginning users, they left it deactivated
by default. Before you do anything else, turn it on.

■ Open the AppleScript folder inside your
Applications folder. You’ll see a folder icon named
ScriptMenu.menu. Drag this icon to your menu
bar (near your clock) and release the mouse button.
The new scroll-shaped Script menu now appears
on your menu bar, as shown in Figure 12.3.
■ Click this menu to see a number of submenus
filled with useful sample scripts supplied by
Apple. Feel free to take some time to try out any
that look interesting to you. A few fun (and some-
what useful) examples include the following:

■ Current Date & Time on the Info Scripts
submenu opens a window showing the current
date and time, with an optional button to copy
this information to the clipboard.
■ Current Temperature by Zipcode on the
Internet Services submenu displays a box for
you to enter your current Zip code. After you’ve
done so, the script checks a weather site on the
Web, gets the current temperature, and displays
it in another window.
■ Crazy Message Text on the Mail Scripts sub-
menu (see Figure 12.4) asks you to enter some
text, which it then uses to create a new Mail mes-
sage in a wacky assortment of fonts, sizes, and
colors. The result is shown in Figure 12.5 (CP.2).

.

Script menu

.

.
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STEP 2: ADD NEW SCRIPTS

Although Apple’s sample scripts are interesting, you
can download hundreds of other scripts that will give
you an astonishing array of features. (Note that the
Scripts menu supports not only AppleScripts but also
shell scripts and perl scripts.)

Here are a few sources for downloading new scripts:

■ Apple’s own AppleScript site at www.apple.
com/applescript/script_menu/ has a
few additional scripts you can download.
■ The sites www.applescriptcentral.com
and www.macscripter.net both have large
collections of AppleScripts and AppleScript-
related information contributed by people from
all over the world.
■ Let’s not forget our old standby, VersionTracker.
Visit www.versiontracker.com, click the
Mac OS X tab, and search for AppleScript for
dozens of additional scripts.

After you have the new scripts, what do you do with
them? You’ll need to put them where the Script menu
can find them.

■ Move your new scripts to the /Library/Scripts
folder. They should appear immediately on the
Script menu. (To avoid making the menu too
unwieldy, you might want to consider grouping
your new scripts into folders, or placing them in
an existing folder if appropriate.)

STEP 3: INSTALL FOLDER ACTIONS
SCRIPTS

Now that you’ve activated the Script menu, you can
explore an even more powerful way of using
AppleScripts: folder actions. A folder action is a script
that’s “attached” to a folder so that it runs automati-
cally when the folder changes in some way. Depending

Automating the Finder with Scripts and Folder Actions 

on what the script is designed to do, it can run when
the folder window is opened, closed, or moved, or
when items are added or removed from the folder —
even if it’s closed.

Just to give you a general idea of the possibilities,
here are some examples of things you could do with
folder actions.

■ Run a series of Photoshop filters automatically
on every file dropped into a certain folder.
■ Convert audio, video, or graphics files to a dif-
ferent format or sort them into different folders
depending on their attributes.
■ Mail, upload, or compress files dropped on a
folder without any further steps.
■ Display an alert box when the content of a
folder changes.
■ Prevent a folder window from ever being
moved or closed.

I should warn you right here that these possibilities,
while intriguing, do come at a certain cost. Unless
someone has already written exactly the script you
need for your ideal folder action, you’ll need to learn
a bit of AppleScript to create your own (or at least
modify someone else’s script). AppleScript is not
hard to learn, but it does take some time to under-
stand and become proficient with it. The Web sites
listed in Step 1 point you to some great online and
print resources for learning AppleScript.

That said, now you can get your feet wet. Although
support for folder actions is built into Mac OS X,
Apple suggests that you download an updated set of
control scripts before beginning to work with them.
Download and install these now.

■ Enter www.apple.com/applescript/
folder_actions/FA_archive.sit into your Web
browser and press Return. The updated scripts
download to your computer. Unstuff the archive
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■ An Open dialog appears, asking you to choose 
a folder to attach the script to. Navigate to any
folder you want to experiment on and click
Choose. Another alert box appears to confirm
that the folder action has been attached.
■ Now you’re ready to try out your new folder
action. Drag a file (again, any file will do) into the
folder you just selected. The alert box shown in
Figure 12.8 appears. Click Yes to open the folder
(if, for example, you want to return the file you
just dragged in to its home) or No if you just want
to dismiss the alert.

 Chapter 3 Customizing Mac OS X

(if it doesn’t happen automatically). A folder con-
taining six scripts appears, as shown in Figure 12.6.
■ Open the /Library/Scripts folder. It should
look something like Figure 12.7. Open the Folder
Actions folder and drag all four scripts inside 
it (Attach Script to Folder.scpt, Remove Folder
Actions.scpt, Disable Folder Actions.scpt, and 
Enable Folder Actions.scpt) to the Trash. Now 
drag the six scripts from the FA_archive folder
you just downloaded into the Folder Actions
folder. You can close the Scripts window.
■ Click the Script menu and choose the Folder
Actions submenu, where you can now see the six
scripts you just installed. Choose Enable Folder
Actions. An alert box appears to confirm that
folder actions have been enabled.

STEP 4: ATTACH AND TRY OUT A
FOLDER ACTION

Pick a folder, any folder. Attach one of Apple’s sample
folder action scripts to this folder and try it out, just
to see how it’s done.

■ Choose Folder Actions from the Script menu;
then choose Attach Folder Action from the sub-
menu. A dialog appears asking you to choose a
Folder Action. (Initially, this list contains only 
the three sample scripts Apple provides, but you
will see how to add your own shortly.) Select 
add - new item alert and click OK.

.

.

.
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That’s all there is to it. Attach a script and make
changes to the folder — the script will run automati-
cally. Feel free to try out the other sample scripts or
just proceed to the next step.

STEP 5: CREATE YOUR OWN FOLDER
ACTION

Now that you know how to attach and use a folder
action, I will walk through the process of creating your
own folder action script from scratch. This is not a
course in AppleScript, so I’m not going to explain the
ins and outs of the script you’re about to use. For more
details on writing folder action AppleScripts, visit
www.apple.com/applescript/folder_
actions or one of the other AppleScript sites men-
tioned earlier. This very simple script sorts files
dropped onto its attached folder according to file
extension.

■ Open Script Editor. It’s located in the
AppleScript folder in your Applications folder.
■ Enter the following code exactly as it appears
here. (Note: Some long lines are split here to fit 
in this column, but should not be split when you
type them. Wherever you see a line break followed
by an indent, type the first line, then a space, then
the text from the second line. Refer to Figure 12.9
if you become confused.)

on adding folder items to this_folder
after receiving added_items

tell application “Finder”
repeat with thisItem in added_items
set fileExt to name extension of

(info for thisItem)
if (not (folder fileExt in this_folder

exists)) then

Automating the Finder with Scripts and Folder Actions 

make new folder in folder this_folder
with properties {name:fileExt}

end if
move thisItem to folder fileExt in

this_folder
end repeat
end tell
end adding folder items to

■ When you’re done, click the Check Syntax but-
ton on the toolbar, and your window should look
like Figure 12.9 (CP.3).
■ Choose Save from the File menu. Enter Simple
Sort.scpt for the name, make sure Compiled
Script is selected in the Format menu, and save it
in /Library/Scripts/Folder Action Scripts.
■ Following the same procedure used in the last
step, attach Simple Sort.scpt (which will now
appear in the Attach Folder Action list) to the
folder of your choice.

.
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STEP 6: ADD FOLDER BADGES

One last detail. In Mac OS 9, attaching a Folder
Action script to a folder automatically added an
AppleScript badge to the folder’s icon, to remind you
that it was no longer an ordinary folder. Automatic
badges are still missing from Mac OS X, but Apple
provides a manual way to badge your folder icons so
you’ll know which ones have attached scripts.

■ Enter this URL in your browser: www.apple.
com/applescript/folder_actions/FAFolder.icns.
sit. If necessary, unstuff the archive, giving you a
file named FAFolder.icns.
■ Select FAFolder.icns and choose Get Info from
the File menu. Click the icon in the Info window
to select it; then press Ô+C to copy it. Close the
Info window.
■ Now select the folder you recently attached a
script to. Again, choose Get Info. Now click the
icon and press Ô+V to paste the badged icon over
it. Close the window, and your folder will be
badged, as shown in Figure 12.11. (If you later
want to remove the badge, just select the icon in
the Info window again and press Delete.)

 Chapter 3 Customizing Mac OS X

■ This script will sort all files dropped onto its
attached folder by extension. If you have a file
ending in a .sit extension, for example, the script
will create a folder named “sit” within the attached
folder and move your file there. This works
whether or not the extension is visible in the
Finder. To try it out, drop one or more files onto
the folder with the attached script. Then open the
folder to confirm that they have been sorted cor-
rectly. Figure 12.10 shows an example of what the
results might look like.

This is a very simple, quick-and-dirty example
script, not one you would likely use every day.
However, you can probably see how it could be
enhanced to deal with many different situations. If
you were to attach an improved version of this script
to your Web browser’s download folder, for example,
you could automatically ensure that all files you
download are sorted into useful subfolders.

. .
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TAILORING THE DESKTOP TO 
YOUR PERSONALITY

I
try very hard to keep my desktop neat and organized — ideally
showing only the icons of my hard drive and other mounted 
volumes. Yet despite my best efforts, it often ends up being a stor-
age place for files I’ve downloaded or created but haven’t taken
the time to sort properly yet. They end up staying there for a long

time, because I usually have a dozen or more windows open at once and
they completely obscure the desktop — I barely know it’s there.

Perhaps you’re neater than I am and keep everything in its place. Or per-
haps your monitor is so large that there’s plenty of room for the desktop to
show through, even with lots of windows open. If so, you’re going to love
this technique for customizing your desktop in some very cool ways. And if
you do keep your screen cluttered like I do, this technique might impress
you so much that you change your ways.



. .

TECHNIQUE 13

The desktop — the back-

ground area of your screen

where your hard drive icon

appears — can do more than

collect files you haven’t

bothered to file any place

else. It can also express your

personality, entertain, or

even relax you.

A B O U T  T H E  F E AT U R E
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■ To cycle through all the pictures in a certain
collection automatically, click Change picture and
choose how frequently you want the pictures to
change. Check Random order to mix things up 
a bit.

After a while, you’re bound to get tired of ladybugs,
dewdrops, and swirly blue patterns. It’s time to replace
Apple’s pictures with ones of your own.

■ If you store your digital photos in your Pictures
folder, choose Pictures Folder from the
Collections menu to display thumbnails of your
own photos. More likely, your photos are organ-
ized in subfolders within the iPhoto Library
within your Pictures folder. To choose a folder of
photos there (or anywhere else), click Choose
folder, and navigate to where your photos are
stored, as shown in Figure 13.4.
■ As before, you can set a single image or create a
slide show of your family vacation by adjusting
the Change picture settings.

 Chapter 3 Customizing Mac OS X

STEP 1: USE DESKTOP PICTURES

This technique starts slowly and works up to the
good stuff. You may have noticed that Apple provides
a selection of images you can use to replace the
default swirly blue pattern. If you haven’t experi-
mented with the other available pictures, that’s a
good place to begin. To replace your desktop pattern,
do the following:

■ Open System Preferences and click the Desktop
icon. The window shown in Figure 13.3 appears.
Under the words Current Desktop Picture is a
miniature version of your current desktop pattern.
■ The pop-up Collections menu lists several sets
of images. When you choose a new collection,
thumbnails of the pictures in that set appear in the
list below. Scroll through each one of the lists to
see the sample pictures. To try out one on your
desktop, simply click it once and it will immedi-
ately appear in the background. (Notice that some
of the images are wider than others — these are
intended for wide-format displays like the Cinema
Display, wide-screen iMac G4, or PowerBook G4.)

. .
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If you can see enough of your desktop to appreciate
it, having pictures of your friends, family, or last
weekend’s car show cycling on your desktop can be
very cool. But you can do better still!

STEP 2: USE A DESKTOP SCREEN SAVER

After the novelty of a desktop slide show has worn
off, it’s time to move up to the heavy-duty stuff: desk-
top animations.

You’ve probably noticed that Mac OS X includes a
built-in screen saver. The Screen Effects pane of
System Preferences allows you to choose and config-
ure screen saver settings. Screen savers, of course, are
animated — either subtly, like the gently panning,
zooming, and crossfading Beach or Forest, or not-so-
subtly, like the psychedelic Flurry setting. You can
also, of course, use the same Pictures folder (or
another folder of your own graphics) for a dynamic,
animated super-slide-show presentation.

One of the coolest hacks to circulate around the
Internet has been a very simple one-line command to
display your selected screen saver as your desktop
pattern — animation and all!

Open your Terminal application. Type the following
all on one line, with no spaces after the / characters
(and paying careful attention to the capitalization).
Then press Return.

/System/Library/Frameworks/
ScreenSaver.framework/Resources/
ScreenSaverEngine.app/Contents/
MacOS/ScreenSaverEngine -background &

You should now have your screen saver running on
your desktop, much like that shown in Figure 13.5.
Cool, eh?

Tailoring the Desktop to Your Personality 

■ Unless you have a very fast computer and a very
expensive graphics card, you’ll probably notice
that running a screen saver on your desktop slows
down the other programs on your computer con-
siderably. To stop the screen saver desktop, go back
to Terminal and enter the following and then press
Return:

killall -m "ScreenSaver"

■ If you don’t want to have to type all that every
time you turn on or off your desktop screen saver,
you could set up aliases to those two commands as
described in Technique 3. If you really don’t like
messing around in Terminal and have a spare $12,
you can download xBack from Gideon Softworks
(www.gideonsoftworks.com/xback.
html), which adds a friendly icon to your menu
bar that allows you to turn desktop screen savers
on and off and configure them with ease.

.
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money just to see the expressions on your cowork-
ers’ faces when they notice fish swimming behind
your hard drive icons!

 Chapter 3 Customizing Mac OS X

STEP 3: USE AN EVEN COOLER DESKTOP
SCREEN SAVER

But wait, there’s more! (Is there an echo in here?)
Although desktop screen savers look cool no matter
which module you’re using, one screen saver is
hands-down the most impressive, gotta-have toy. It’s
called SereneScreen, and it turns your screen into an
incredibly realistic virtual aquarium, complete with
bubbles and sound effects (if you want them). The
wide variety of tropical fish are rendered on-the-fly,
and with a high-end graphics card, the effect is
absolutely stunning (see Figure 13.6.) Is that not
groovy?

■ You can download a free demo version of
SereneScreen from www.serenescreen.com;
the full version costs $21.95. Although the demo
works fine as a regular screen saver, it does not
work as a desktop background. The full licensed
version does, however, and it’s well worth the .
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GETTING MORE FROM AQUA WITH 
HIDDEN PREFERENCES

I
’m going to let you in on the worst-kept secret in Mac OS X. You
can customize a large number of features far beyond the options
in Preferences dialogs — all without any special tools or pro-
gramming knowledge — if you just know where to look (and you
will momentarily). Mac OS X makes exploring and tweaking 

the Finder and other applications much easier than they ever were in the
Mac OS 9 days. It also allows you to discover some features that were always
present but not visible in the user interface.

In this technique, you’ll learn about two key ways of customizing the hid-
den features of Mac OS X. I’ll take you through the whole process with the
Finder to show you how it’s done manually and then show you a free
graphical app called TinkerTool that can do many of these things for you
with just a few clicks. If there’s an easy way, why even mention the hard
way? Simple: You’re learning techniques here. TinkerTool does a great job
of modifying the Finder and the Dock, but you can apply the manual
method you learn here to other applications as well.



. .

TECHNIQUE 14

The Finder — as well as the

Dock and other programs —

include hidden settings that

enable interesting new fea-

tures. With a little explo-

ration, you can tap into this

extra power.

A B O U T  T H E  F E AT U R E
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List Editor. The preceding file is shown in Property List
Editor in Figure 14.4. If you were to make changes to
this file, save it, and then relaunch the Finder, you
would find that the changes took effect exactly as if
you had changed them using the Finder Preferences
dialog. To modify property lists, do the following:

 Chapter 3 Customizing Mac OS X

But, first, I must again warn you: Messing with your
system has the potential to, well, mess up your sys-
tem. I urge you to back up all your work before trying
any of this. Better yet, if you can experiment on a spe-
cial installation of Mac OS X (on a separate drive or
partition from your main system — or even on a dif-
ferent computer) you’ll have a safety net in case
something goes wrong. That warning duly rendered,
you can dig in.

STEP 1: EDIT PROPERTY LISTS 
(THE HARD WAY)

If the thought of fiddling with hidden parts of your
operating system that Apple clearly intended to be
invisible fills you with dread, you can skip this step
and move on to Step 2. If you’re curious about the
way things work, though, you may find this step
interesting.

A property list is another name for a preference file.
In the old days, each application stored its prefer-
ences in a different format, many of which could not
be read or edited by any other application. Under
Mac OS X, the property lists that store preferences for
most applications are simple text files, formatted
using a system called XML (for eXtensible Markup
Language).

If you opened one of these files in a text editor like
TextEdit, you would see something like Figure 14.3,
which shows a small portion of the Finder’s prefer-
ence file. As you can see, it’s not exactly poetry, but
there are some plain English words in there, and with
a bit of thought, you can probably see what some of
the lines mean. Interestingly, this file gives you access
to settings that don’t appear in Finder Preferences (or
anywhere else in the graphical user interface). They’re
built-in features, but the controls to modify them are
hidden in this text file. Even more interestingly, if you
want to experiment with these settings, you don’t
have to wade through XML in a text editor. You can
use a much more attractive tool Apple supplies as
part of the Developer Tools package called Property .

There are other ways to make changes to your

hidden preference files besides using Property

List Editor. For example, if you know exactly

what command to use, you can type a one-line

command in Terminal that begins write
defaults com.apple.finder (followed by

some other parameters) to change the settings.

I show you this way so that you can easily see

where the settings are stored and how they’re

used.

N OT E
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■ If you haven’t already done so, run the installer
on the Developer Tools CD that came with Mac
OS X. (If you’ve already tried out Technique 3,
you’re good to go.) The Property List Editor appli-
cation you’ll be using is part of that installation.
■ Open Property List Editor. It’s in the
Applications folder inside the /Developer folder.
■ Choose Open from the File menu, type the fol-
lowing in the Go box (with no space after the /
character), and click Open:

~/Library/Preferences/
com.apple.finder.plist

■ When the new window opens, click the disclo-
sure triangle next to Root; you’ll see something
like Figure 14.4. This is the Finder’s preference
file. Some of the items in here might make no
sense to you at all, but others will be fairly obvious.

The first thing you’re going to do is add a Quit com-
mand to the Finder. It doesn’t normally have one
because it’s supposed to be running all the time. But
there are times you might want to be able to turn it
off temporarily (like when you’re playing with Finder
settings).

Getting More from Aqua with Hidden Preferences 

■ Click any of the items under Root to enable the
New Sibling button. Click New Sibling, and in the
new field that appears, enter QuitMenuItem.
Click in the Class column to display a pop-up
menu of field classes; choose Boolean, which sim-
ply means this is a “yes/no” (or on/off) value.
Then click in the Value column to display another
pop-up menu of available values; choose Yes from
this menu, as in Figure 14.5.
■ Save the file by choosing Save from the File
menu. (You can leave the file open.)
■ Choose Force Quit from the Apple menu 
(or press Ô+Option+Esc). When the Force 
Quit window appears, select Finder and click
Relaunch. (Don’t worry, this is perfectly safe.)
Your Finder quits and restarts in the background.
■ When all your icons reappear, click the Finder
icon in the Dock to bring it to the front. Click on
the Finder’s File menu, and behold! It now has a
Quit command. You will use this command
shortly.

Congratulations! You just performed your first
Finder hack. Read on to make a few more easy
changes.

. .
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more than three lines.) Figure 14.7 shows a folder
containing some long filenames before and after
applying this change.
■ The last change you’ll make is to turn off Zoom
Rectangles. As you may have noticed, opening an
application causes an animation effect that looks 
a bit like a rectangle springing out of the spot
where you clicked to fill the screen. If you find 
this animation annoying, you can use a hidden
preference to turn it off. Enter a new sibling called
ZoomRects. Make it a Boolean item with a Value
of No.

 Chapter 3 Customizing Mac OS X

■ Back in Property List Editor, repeat the New
Sibling procedure by adding an item called
AppleShowAllFiles. Once again, this is a Boolean
on/off switch. Entering Yes for the Value makes
the Finder display all files, even ones that are
invisible, like the hidden files that make up the
UNIX layer of Mac OS X. (See Figure 14.6.)
■ Add a sibling called MaximumLabelLines.
This time the Class is a number. This number is the
maximum number of lines that will be used to dis-
play file and folder names when you’re in Icon
View. If you have some really long filenames, two
lines might not be enough to display them, result-
ing in part of the name being cut off. Enter 1, 2, or 3
in the Value column. (Although you can enter any
number you want, the Finder will never display

.

Being able to see hidden files in the Finder can

be educational — and occasionally useful —

but if you accidentally delete some of these

files, you can cause serious damage to your sys-

tem. This is one setting I recommend turning on

only when you need it and then turning it off

again.

WA R N I N G

.

03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 92



■ As before, save the file. You’re finished in
Property List Editor, so you can also quit the
application now.
■ Now switch to the Finder. Before your changes
can take effect, you’ll need to quit it and restart it.
Conveniently, your Finder now has a Quit menu
command on the File menu. Choose it now. This
time, the Finder may not restart on its own. If not,
click the Finder icon in the Dock to relaunch it.

Enjoy your new Finder features! If you ever want to
return to your defaults, follow the procedures in this
step again and replace your new values with the old
ones.

Using this same technique, you can examine and
modify other preference files. The Dock, for instance,
has some interesting hidden preferences (found in
com.apple.dock.plist), which you modify by other
means in Technique 15. Before modifying any other
preference files, make a backup copy — just so you
can restore the file to its previous state if you acciden-
tally make a change that has unexpected results.

STEP 2: USE TINKERTOOL (THE EASY WAY)

If you want to save yourself a few steps, a freeware
application called TinkerTool can make these and
many other hidden Finder changes for you using a
convenient, friendly graphical interface. TinkerTool
can do a great many things, but I talk about just a few
here. To use TinkerTool, do the following:

■ Go to www.bresink.de/osx/
TinkerTool2.html and download
TinkerTool.
■ Double-click and run the installer.
■ When installation has finished, System
Preferences opens automatically. Click the
TinkerTool icon (at the bottom under Other),
and you’ll see the TinkerTool pane, as shown 
in Figure 14.8.

Getting More from Aqua with Hidden Preferences 

■ The Finder tab includes controls to change the
same settings you modified earlier. Check the
appropriate checkboxes to enable or disable zoom
rectangles, the display of hidden files, and the
Finder’s Quit menu command. To change the
number of lines used to display filenames, make 
a selection from the Icon View pop-up menu.
Another option is listed here that we didn’t edit
before: Disable arrows. Click this checkbox to
hide the display of arrows in Column View to
indicate which items (folders and volumes) will
display their contents in another column when
clicked.
■ When you’re finished making changes, click
Relaunch Finder to activate them.

TinkerTool’s other tabs allow you to modify addi-
tional hidden preferences, including Dock position,
scroll bar arrow placement, system font settings, and
the language used for Startup and Login screens. If
you ever want to restore your preferences to their
original, uncustomized state, the Reset tab allows you
to do that with one click.

.
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DOCTORING YOUR DOCK

I
n Mac OS 9, lots of interface elements were used for opening files,
displaying status, or executing commands. Some examples were
the Apple menu, the Application menu, the Control Strip, and the
Launcher utility. In Mac OS X, Apple has attempted to bring the
best features of all these widgets into one place: the Dock.

Most people who see the Dock for the first time think, “Wow, that’s cool!
Look at those large, beautiful icons! Watch that snazzy “genie” minimizing
effect! And ooh, see the way those icons grow and shrink as I move the
mouse over them!” After a while, though, it’s easy to become frustrated
with the Dock. You might find, for example, that it gets in your way as you
try to do your work or that it doesn’t have all the functionality you were
hoping for. Fear not, for in this technique, you learn how to customize the



. .

TECHNIQUE 15

The Dock is one of the most

distinctive features of Mac

OS X’s user interface. Equal

parts file launcher, applica-

tion switcher, status indica-

tor, and eye candy, the Dock

wears many hats, but can

also do much more than

meets the eye.

A B O U T  T H E  F E AT U R E
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■ System Preferences is another application you
may use frequently, but opening System
Preferences with a single click is always easy — 
it’s on your Apple menu. You don’t need to have 
it in your Dock as well.
■ A couple of the icons are used to open iApps
that require special hardware. If you use them fre-
quently, having them in the Dock can be handy,
but if not, consider removing them. If you don’t
have a digital camcorder, you probably don’t use
iMovie (the clapboard icon) very often, so you can
remove that icon. Likewise, the iPhoto icon (the
camera in front of a photograph) is primarily use-
ful to those with digital cameras, and if you don’t
have one, you probably won’t be using iPhoto very
often. Remember, if you get new toys later and
want to add these applications back into your
Dock, doing so is a piece of cake.

I’ll let you decide about the rest of the icons. As a
general rule, if you don’t use a particular application
at least once a week, it’s probably not a good use of
space in your Dock. If you use it several times a day,
you’ll be very glad to have it there.

STEP 2: ADD USEFUL ICONS TO YOUR
DOCK

The next step is to add to your Dock icons for appli-
cations and other files you need very frequent access
to — that is, more frequent than the icons you just
removed! In addition, you add some special icons
that may not be obvious, but which can save you lots
of extra clicking.

■ To add an item to the Dock, just locate the file
or folder you want and drag its icon into your
Dock. All applications must go on the left side of
the vertical line; everything else (like files, folders,
and URLs) goes on the right side. Apart from that
limitation, you can put your new icons anywhere

 Chapter 3 Customizing Mac OS X

Dock to within an inch of its life, replacing annoy-
ance with utility — and having a bit of fun in the
process. To make this process even more interesting,
you do all of this without opening System Preferences
even once!

STEP 1: REMOVE ICONS YOU DON’T USE

Before you do anything else to the Dock, or even
decide how large or on what part of the screen it will
be, you should decide what goes in it. Out of the box,
as shown in Figure 15.3, your Dock contains icons
for the Finder and Trash (which can never be
removed), System Preferences, and a handful of
important applications such as Mail, Internet
Explorer, and iTunes. However, you can freely remove
any icons you don’t use regularly — knowing that
you can add them back later if you change your
mind. The first step to having a useful Dock is to
weed out icons you don’t use often.

■ The first icon you can remove is the one next to
the Trash — it looks like an @ symbol on a spring.
Clicking this icon simply takes you to the Mac OS
X page on Apple’s Web site. Because there are lots
of other ways to get there, there’s no need to keep
this icon. Click and drag it off the Dock, and a lit-
tle “poof” animation will confirm its deletion.
■ Next, consider removing the QuickTime Player
icon (the blue Q). Although you might use
QuickTime Player frequently, if you’re like most
people, you’ll rarely, if ever, need to open it manu-
ally. Instead, you’ll probably double-click movies
and other media files you’ve downloaded, opening
the QuickTime Player automatically. So drag off
the blue Q as well.

.

03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 96



you want; the other icons will scoot out of the way
as you add new ones. You can also rearrange icons
at any time by clicking and dragging them to
another spot in the Dock. Try this now with any
random file, and if it’s not one you want to keep 
in the Dock, you can drag it right off again.
■ Consider the applications you use frequently.
Perhaps you use Microsoft Office and work in
Word, Excel, and Entourage all day long. Or per-
haps you’re a designer constantly switching among
Photoshop, Illustrator, and InDesign. Whatever
your work style, decide on the applications you use
the most. Look through your Applications folder
(and any other folders within the Applications
folder) and add your most frequently used apps —
but no more than five or six — to the Dock now.
■ Next think about individual folders that you
access frequently, like your home folder, your
Documents folder, or perhaps a document you’re
working on over a long period of time. Drag these
to your Dock as well (remembering that they need
to go on the right side of the vertical divider).
Again, don’t overdo it — too much clutter defeats
the purpose of the Dock, which is simplicity.
Figure 15.4 shows a Dock customized with a new
set of applications and folders.
■ Now for some less-than-obvious goodies. First,
you can actually drag your hard drive icon into the
Dock (Figure 15.5). As you will see in a moment,
by doing this, you can get one-click access to most

Doctoring Your Dock 

of your files with a handy pop-up menu. If you
find yourself constantly clicking to open and close
windows, this can be a great timesaver. As with
other non-application icons, your hard drive will
go on the right side.
■ Finally, my favorite: Put your desktop in the
Dock, as shown in Figure 15.6. Although it may
not look like it, your desktop is actually a special
folder, and you can display all the files on your
desktop in a regular window. You can also add this
folder to the Dock, allowing you to see and open
files on your desktop, even when you have so
many other windows open that you can’t see the
desktop at all! To do this, open your home folder
(the folder in the Users folder with your user
name), find the Desktop icon, and drag it into 
the Dock — on the right side, of course.

STEP 3: ORIENT AND SIZE THE DOCK

When you first install Mac OS X, the Dock appears
full-size at the bottom of your screen. If you have a
Cinema Display (lucky you!) or multiple monitors,
this might be fine. But for the average user with a sin-
gle monitor at 1024 × 768 pixels, it’s a terrible use of
screen real estate. Because your monitor is wider than
it is tall, you need to make the most of the vertical
space you have available, and having the Dock use up
so much of it leaves you with very little room for your
own stuff. Luckily, this is easy to change.

■ The easiest way to change the size of your Dock
is to move your pointer to the thin vertical line
that separates your applications from everything

.

. .
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defaults write com.apple.dock
pinning start

You need to quit and restart the Dock in order to
see your changes. You can do this either by logging
out and logging back in or by typing

killall "Dock"

If you want to undo your change to the Dock pin-
ning location at some point, type (all on one line)

defaults write com.apple.dock
pinning middle

Figure 15.8 shows a Dock on the right side of the
screen, pinned to the bottom corner. One of the

 Chapter 3 Customizing Mac OS X

else. As you can see in Figure 15.7, the pointer shape
changes to a bar with arrows above and below. Now
you can simply click and drag up or down to change
the size of your Dock. It’s possible to make it very
tiny indeed, if that is your preference.
■ Your Dock does not need to go at the bottom of
the screen — you may prefer to have it on the left
or right edge instead, where space is at less of a
premium. To orient your Dock vertically on the
side of the screen, move your pointer to the vertical
line again so that it changes to the double-arrowed
bar. Now hold down the Shift key, then click and
drag up and to the right to position it on the right,
or drag up and to the left to position it on the left.

By default, your Dock will be centered on the edge
of the screen where you’ve positioned it. But it’s also
possible to make it stick to one corner — for exam-
ple, the lower-right corner — so that it will grow out
to the left (if it’s on the bottom) or toward the top (if
it’s on the right). This feature can make finding icons
like the Trash easier, because they’ll always be in the
same position on the screen no matter how many
other items you add to the Dock.

■ To make your Dock stick to the right or bottom
corner, open a Terminal window and type (all 
on one line, with a space between “dock” and 
“pinning”)

defaults write com.apple.dock
pinning end

■ To make your Dock stick to the left or top 
corner, open a Terminal window and type (all 
on one line)

.

If you hold down the Option key while resizing

your Dock, it will snap to certain fixed sizes at

which the icons look best (corresponding to

icon dimensions of 16 × 16, 32 × 32, 48 × 48,

64 × 64, and 128 × 128 pixels). For reference,

the next-to-smallest fixed size (32 × 32) is the

size all icons were in Mac OS 9. Don’t they seem

small now?

T I P

.
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advantages of keeping your Dock in the lower-right
corner is that your Trash will always stay put in the
same corner of the screen where it always used to be.

STEP 4: RIGHT-CLICK DOCK ICONS

Most people use the Dock only for opening and
switching applications. But its capabilities go way
beyond that. Every item in your Dock is also a pop-
up menu, with contents that vary depending on what
type of item it is, and — if it’s an application —
whether it’s running.

Ordinarily, the pop-up menus only display if you
click and hold the mouse button on an icon for about a
second. But you can avoid that delay with a right-click.

■ For instantaneous access to Dock menus,
right-click the icon with your multi-button mouse
(or Control+click if you’re using a one-button
mouse).

Here are some examples of what you’ll see on the
menus:

■ All running applications show a list of their
open windows. So if you have Word running in
the background with ten windows open, you can
jump directly to the window you want by right-
clicking Word’s Dock icon and choosing that 
window name from the pop-up menu.

Doctoring Your Dock 

■ The commands Show in Finder and Quit also
appear on applications’ pop-up menus. Choose
Show in Finder to open the window containing
the application’s icon, or Quit to quit the applica-
tion without first switching to it. (If an application
isn’t responding, you can press the Option key
while clicking the icon to change Quit to Force
Quit; this method is quicker than pressing
Ô+Option+Escape and choosing the application
from a list.)
■ Most applications show additional commands
in their pop-up menus. Mail, for example, as
shown in Figure 15.9, enables you to Get New
Mail or Compose New Message without switching
to the application first. Meanwhile, iTunes shows
you the name of the current artist and song along
with numerous other controls. Some applications
have dozens of options available. Experiment with
the ones you use to see what commands are 
available.

There are other ways to edit the hidden Dock

preferences that control how it’s displayed. One

way is to use Property List Editor to modify the

com.apple.Dock.plist file, just like you did in

Technique 14 for the Finder. Another way is to

use the freeware TinkerTool application (also

discussed in Technique 14) to edit these settings

in a graphical interface.

N OT E

.

By using modifier keys (like Ô and Option)

while clicking Dock icons, you can selectively

show and hide applications, display the applica-

tion icon in the Finder, and other neat tricks.

These and other Dock shortcuts are listed in

Appendix A.

T I P
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Figure 15.10 for an example. When you move the
pointer away from the Dock, they all return to
normal size. (Be aware that if you have your Dock
anchored to a corner, magnification will cause
some icons to disappear off the edge of the screen
momentarily.)
■ To turn off magnification, once again choose
Icon Magnification from the Dock submenu.

If even very small icons take up too much space for
your taste or are too distracting, you can hide the
Dock altogether. Even when it’s hidden, it’s still run-
ning, though, and will reappear instantly when your
mouse approaches the edge of the screen where it’s
positioned.

■ To turn on Hiding, choose Dock from the
Apple menu and choose Automatically Hide the
Dock from the submenu (or press Ô+Option+D).
To turn off Hiding, repeat this step.

 Chapter 3 Customizing Mac OS X

■ If you have a volume (like your hard drive) or a
folder (like your desktop folder or home folder) in
the Dock, right-clicking or Control+clicking dis-
plays a hierarchical menu of all the files and folders
inside it. This means that with a single click, you
can open nearly any file, even if it’s buried several
levels deep. One caveat, however: Pop-up Dock
menus only go five levels deep.

STEP 5: USE MAGNIFICATION AND 
HIDING

If you place a lot of icons on your Dock, it shrinks in
order to accommodate them all. Even if you took a
more conservative approach and have only a few
Dock icons, you may want to keep your Dock small
to save precious screen space. If the icons get too
small, though, it can be difficult to tell what they are
(not to mention difficult to click them accurately).
Dock magnification can solve this problem.

■ To turn on magnification, choose Dock from
the Apple menu and choose Icon Magnification
from the submenu. As your pointer enters the
Dock, the nearest icon will grow to full size, and
the ones on either side will scale partway up. See .
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STEP 6: CUSTOMIZE APPEARANCE AND
BEHAVIOR

If you have the hang of using the Dock and are still
hungry for more, a number of downloadable pro-
grams can take you even further.

■ Try out TinkerTool, the free preference pane
mentioned in Technique 14; it can perform several
Dock modifications for you quickly and safely
with a friendly graphical interface — including
the stick-to-a-corner trick used earlier. You can
find it at www.bresink.de/osx/
TinkerTool2.html.
■ To customize your Dock further, try the share-
ware program TransparentDock, available from
www.freerangemac.com/pages/
software.html for a mere $8. In addition 
to the Dock-related features of TinkerTool,
TransparentDock allows you to change the color
and transparency level of the background, border,
and even the application arrows on your Dock.

Doctoring Your Dock 

And that’s just the beginning. You can replace the
Poof effect with your own animation, display hid-
den files in pop-up menus, or — my very favorite
feature — eliminate the five-levels-deep feature
for hierarchical menus.
■ For the ultimate in Dock customization, look
no further than Skin a Dock, a $10 shareware pro-
gram available from www.ittpoi.com/
skinadock.html. This amazing program
allows you to change the overall appearance of
your Dock in extreme ways, such as adding flames
or grass around the icons or placing each icon in
its own bubble. Figure 15.11 shows two examples.

.

03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 101



03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 102



MOVING BEYOND THE DOCK 
WITH FILE LAUNCHERS

I
f you’ve read Technique 15, you may be feeling pretty excited
about all the things your newly customized Dock can do for you.
Now I’m going to turn the tables on you and propose something
shocking: You might want to stop using the Dock almost entirely
and replace it with something else! Even though the Dock is

pretty to look at and can be customized extensively, it remains limited in
some important ways. Power users often choose to skip the Dock and use a
third-party file launcher utility instead.



. .

TECHNIQUE 16

File launchers are small utili-

ties that make finding and

opening your favorite appli-

cations, utilities, files, and

URLs easy. The Dock can do

all of this, too, but a number

of third-party alternatives

do it better.

A B O U T  T H E  F E AT U R E
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above your other windows; some appear or disap-
pear when your pointer moves in and out of a 
certain part of the screen; some behave more like
regular windows; and so on. The best launchers
allow you to choose the sort of window shape,
position, and behavior that suits your needs.
■ How easy is it to customize? Although you 
can customize every launcher in one fashion or
another, some make it very easy whereas others
require a series of awkward steps.
■ Does it offer keyboard shortcuts? This feature
may or may not be important for you, but some
launchers offer the option to assign keyboard
shortcuts to individual items, for another way 
of opening them if using the keyboard is more
convenient than clicking.
■ What does it look like? Some launchers have
highly customizable appearances (sometimes
called skins) that can adapt to your personality;
others have just one set look. Some offer Aqua-
friendly drop shadows, transparency, and rounded
edges; others have a more distinctive appearance.
Your launcher will be a regular fixture on your
screen, so choose one you’ll enjoy looking at.

With these thoughts in mind, here is a sampling of
the best-known (and arguably the best) third-party
launchers you can find. (For more choices, visit
www.versiontracker.com and search the Mac
OS X area for “launcher.”)

■ Aladdin’s DragStrip ($20,www.aladdinsys.
com/dragstrip) has been around for
many years and is now available in a fully 
Mac OS X–native form. This relatively conven-
tional launcher arranges your shortcuts on a
series of tabs within a floating window. DragStrip
is shown in Figure 16.3. DragStrip is easy to use
but relatively light on features and customiz-
ability. Unlike the other two launchers mentioned
here, DragStrip doesn’t allow you to display a
hierarchical menu showing the contents of folders
and volumes on its tabs.

 Chapter 3 Customizing Mac OS X

What exactly is a file launcher? There’s no set answer
to this question, but in general, a file launcher is a util-
ity with the following features:

■ Opens files, folders, applications, and URLs
with one click.
■ Allows you to drag and drop files onto its icons
to open them.
■ Shows you which applications are currently
running (a process viewer).
■ Enables you to group items into categories

The Dock has all these features except the last one,
but that’s pretty crucial. Although you can, in theory,
drag hundreds of items into the Dock, beyond a cer-
tain number of items the utility and charm of the
Dock drop off rapidly. The Dock’s icons become
small and difficult to pick out, and even with the
magnification feature, using it can be awkward. (On
an average-sized monitor, a Dock with more than 
25 or 30 icons starts getting pretty crowded.) As this
technique shows you, third-party file launchers pick
up where the Dock leaves off, allowing you to organ-
ize dozens or even hundreds of items for quick and
easy access.

Although you can hide the Dock and remove every-
thing except the Finder and the Trash, you can’t com-
pletely turn it off — at least, not without some serious
hacking that might be more harmful than helpful.

STEP 1: CHOOSE A LAUNCHER

Because you’re going to be using your file launcher
many times a day, choosing one that closely meets
your needs pays off. Your first step is to choose a
launcher from among the many that are available.
Fortunately, you can download and try out any or all
of them for free. As you’re evaluating file launchers,
here are some questions to consider:

■ Does it use screen space effectively? A launcher
that covers too much of your screen will get in the
way of your work. Some launchers always float
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■ Drop Drawers X ($20,www.sigsoftware.
com/dropdrawers/) is an unusual and visu-
ally striking launcher that has many enthusiastic
fans. Instead of windows or palettes, Drop
Drawers X places tabs on any edge of your screen.
Move your pointer to a tab to slide out a drawer
(as in Figure 16.4). A drawer can contain not only
applications but also just about any type of con-
tent, including text snippets, URLs, movies,
aliases, and even a Trash icon. (Thus, it can also
serve as a kind of pasteboard or scrapbook for
various sorts of information.) A Process Drawer
shows just currently running applications. Drop
Drawers X has extensive customization options,
but has a steeper learning curve than DragStrip or
DragThing (mentioned next).
■ Last but not least is my favorite, DragThing
($25,www.dragthing.com). Like DragStrip,
it can display shortcuts of all kinds as icons on
floating palettes. Like Drop Drawers X, its multi-
tabbed windows can be turned into pop-out
drawers at the edges of your screen (as shown 
in Figure 16.5). And like the others, it contains 
an optional process viewer window. Where
DragThing really shines is in the depth of its inter-
face choices. Nearly any size, shape, color, texture,
or configuration of launcher you can dream up
can be created with DragThing. Although it has 
a vast number of customization options, I find it
more intuitive and easier to use than the other two.

Moving Beyond the Dock with File Launchers 

One minor caveat: Three of the Dock’s features do
not (yet) appear in any third-party launcher. First, it
uses badges for certain icons to give you additional
information. An example of this is the Mail icon in
the Dock, which displays the number of unread 

.

.

.
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Drawers X and DragThing) that can display the
contents of folders in a pop-up menu. Having a
custom icon for your folder also helps — see
Technique 11 for instructions.
■ Think about the files you need to access on a
regular basis. The files that you’ll find most helpful
to have in your launcher are those that you work
on over long periods of time — a book or a term
paper, for instance — or ones you have to update
frequently, such as a schedule or form. You might
also include instruction manuals or reference
guides in PDF form that you regularly consult.
■ Consider adding a few URLs. In many cases,
your browser’s bookmark menu is a more conven-
ient place to store URLs, but a launcher can give
you one-click access to some of your favorites
even if your browser isn’t already running.

 Chapter 3 Customizing Mac OS X

messages (see Figure 16.6) without requiring you to
switch to the Mail application. Second, by right-click-
ing (or Control+clicking) the Dock icon of a running
application, you can display a menu of open windows
and other commands you can activate without hav-
ing to switch to the application first. Finally, only the
Dock (by way of its bouncing icons) lets you know
when an application is in the process of launching.
The good news is that because you can’t entirely
replace the Dock, it will still offer all these capabilities
for your running applications. You can continue to
use your Dock for what it’s best at and use another
launcher for everything else.

STEP 2: ORGANIZE YOUR LAUNCHER
ITEMS

Now that you’ve chosen a launcher, what do you do
with it? Well, it’s time to load it up with your stuff.
This is an art, not a science, so all I can offer are some
general principles to consider:

■ You’ll invariably want to start by putting your
most frequently used applications on your
launcher. Applications generally go on a tab by
themselves. If you have dozens of applications 
you use on a regular basis, consider splitting them
into several tabs, such as Business Applications,
Internet, Utilities, and Games (or whatever makes
the most sense to you). An example is shown in
Figure 16.7.
■ Next, add the folders you access most often.
This will work best with launchers (like Drop

.

All the launchers described in this technique are

based on the same metaphor as the Dock: an

area of the screen dedicated to launching the

items you have manually selected as being

important. An entirely different — and much

more powerful — paradigm is employed by the

highly regarded LaunchBar utility. Although it

serves the function of launching files, it does so

in a way that does not require any space on the

screen, relying on the keyboard rather than the

mouse. Because it’s more keyboard-oriented,

LaunchBar is discussed in Technique 19,

“Boosting Your Keyboard Efficiency.”

T I P
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■ As you add more items, be careful to limit the
number of icons on any given tab. When a tab gets
to ten or twelve icons, consider splitting its con-
tent into two tabs with more specific titles; for
example, “Expense Reports” and “Budget
Worksheets” instead of “Spreadsheets.”
■ Finally, do not try to put every icon you can
think of in your launcher. If all you’re doing is
duplicating the contents of your Applications
folder, for example, you’re missing the point of
a launcher — quick, easy access to the items you
use most often. A launcher that’s cluttered with
too many items won’t save you any time or 
effort. Concentrate on the items you use most 
frequently — or have to dig the most to find.

STEP 3: CUSTOMIZE YOUR LAUNCHER

After the hard work of organizing your applications
and files, it’s time to have some fun by customizing
the appearance of your launcher. Choices like color,
pattern, and fonts are purely a matter of personal taste
and will depend on the capabilities in the launcher
you’ve chosen. However, here are some practical con-
siderations to keep in mind:

■ All things being equal, a larger target is easier to
hit than a smaller one. In choosing the size of your
icons and views, think about how easy it will be to
click the individual items without carefully posi-
tioning your pointer.
■ Icons, as long as they’re distinctive, can be rec-
ognized more quickly than text. If you have many
identical folder icons, for example, that you can
identify only by reading their labels, your eye will
always have to read the labels to decide which is
the right icon. On the other hand, the eye can eas-
ily detect an icon with a unique color or shape,
making for faster recognition.
■ In contrast to the last two items, text usually
takes up less space than icons. If you have a great

Moving Beyond the Dock with File Launchers 

many items in your launcher and want to keep it
from covering half your screen, smaller icons with
accompanying text labels — perhaps to the side of
the icons, where they use space more efficiently —
might do the trick.

STEP 4: PARE DOWN YOUR DOCK

Now that you have a great launcher, what about your
Dock? It will still always display the Finder, Trash, and
icons for any open applications. But you can remove
everything else from it, because all those other icons
are already in your launcher. (It can feel sacrilegious
or even scary to think about removing everything
from your Dock, but just remember: They’re only
shortcuts. The original applications are still there,
and you can add them back to your Dock later any
time you want.) As a final touch, if you haven’t done
so already, move your Dock to an obscure area of the
screen, make it smaller, and/or turn on Hiding to
keep it out of your way. Figure 16.8 shows a Dock
with only the essentials (and running applications),
pinned in the bottom-right corner of the screen
using the tricks in Technique 15.

.
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RESTORING “MISSING” CLASSIC 
FEATURES TO MAC OS X

N
o one will dispute that Mac OS X has made tremendous
strides in the area of user interface. By comparison, the
Platinum look of Mac OS 9 seems old-fashioned and
passé. Yet, there’s no escaping the fact that Mac OS 9
had some very handy interface features that, for reasons

only Apple knows, have not found their way into Mac OS X.
Maybe you’re a long-time Mac user who still hasn’t gotten used to the new

ways of Mac OS X and pines for the good old days. Or maybe you love
every drop of Aqua, but still think a few things could be more convenient
than they are. Whatever the case, in this technique, I show you how to
restore several features to Mac OS X that were once present in Mac OS 9. In
most cases, the Mac OS X versions of these features are even better than
they were before.

Most of the steps in this technique involve the use of shareware programs.
They’re all quite inexpensive, though, and considering the tremendous effort
these authors have put into making our lives a bit easier, I think every program



. .

TECHNIQUE 17

Mac OS 9 is dead! Long live

Mac OS 9! A number of use-

ful interface features in the

Classic Mac OS disappeared

in Mac OS X. Clever pro-

grammers have found ways

to bring some of them back.

A B O U T  T H E  F E AT U R E
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STEP 2: ADD A CLASSIC-STYLE 
APPLICATION MENU

In Mac OS 9, the right side of the menu bar displayed
the Application menu, which in those days meant a
list of your running applications. With one click, you
could not only switch applications, but also hide all
the windows of the current application or hide every-
thing but the current application. Although you can
achieve similar functionality through a combination
of the Dock and the Window menu, it’s just not as
easy as it once was.

■ Download Frank Vercruesse’s ASM ($12,
www.vercruesse.de/software), which
brings back the functionality of the old
Application menu, as shown in Figure 17.5. It
actually goes far beyond it, giving you the option

 Chapter 3 Customizing Mac OS X

mentioned here is well worth the requested fee. If you
use these programs beyond the trial period, be sure to
register the software and pay the shareware fee.

STEP 1: RESTORE THE APPLE MENU TO
ITS FORMER GLORY

Mac OS X’s Apple menu displays system-wide com-
mands like System Preferences, Recent Applications
and Documents, Restart, and Shut Down. In Mac OS
9, the Apple menu, apart from being more colorful,
had a few additional tricks. For one thing, it was pos-
sible to add your own files and folders to the Apple
menu. Folders displayed their contents in a handy
pop-out submenu, providing a way to get one-click
access to most of your files (much like you can do
now in the Dock).

One of the folders that appeared in the Apple menu
automatically was the Control Panels folder. Because
each control panel had its own entry in this menu,
you could access any one of them with a single click.
(See Figure 17.3.) By contrast, although Mac OS X’s
Apple menu has a System Preferences command, it
takes another click after the application opens to
select the particular pane you want to use — not
quite as convenient.

■ To make your Apple menu customizable once
again, download Unsanity’s shareware FruitMenu
($10,www.unsanity.com). With FruitMenu
installed (see Figure 17.4), you can add folders
and files to your Apple menu much like you could
in Mac OS 9. The hierarchical menus are even bet-
ter, because they’re unlimited in depth. (Mac OS 9
restricted you to five levels.) You can also add any
of a large collection of special commands to your
Apple menu, such as commands to arrange your
windows or display your IP address. Best of all,
instead of a single System Preferences command,
you get a menu listing each pane, so you can jump
to any pane with a single click. .
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Restoring “Missing” Classic Features to Mac OS X 

never broken the habit of zipping your pointer to
the upper-right corner to hide your current appli-
cation, ASM will be a breath of fresh air.

STEP 3: REPOSITION SCROLL BAR
ARROWS

This very easy step requires no extra software, but
removes a major annoyance for people accustomed
to Mac OS 9. When you install Mac OS X, you’ll
notice that the Up and Down arrows on your scroll
bars are together at the bottom. Every previous version
of the Mac OS, as well as every version of Windows,
put the Up arrow at the top and the Down arrow at the
bottom — where, I think you’ll agree, they make more
sense. Figure 17.6 illustrates the difference.

.

. .

to display Dock menus in your ASM menu,
change icon size, and many other options. If you’ve
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STEP 5: RESTORE FINDER LABELS

Although Mac OS X makes sorting files by criteria
like name, date modified, and kind easy, Mac OS 9
offered an additional option called Labels. With a
simple menu command, you could give any file or
folder one of seven user-defined color and name
combinations. When you applied a label, the file’s
color would change, and you could also use your
label as a sorting criterion in List View — for exam-
ple, displaying all the files you’ve designated as “Hot”
at the top of the list, and “Boring” at the bottom.

■ Go visit our friends at Unsanity (www.
unsanity.com), who have brought back Labels
in all their glory with their $10 Labels X, as shown
in Figure 17.9 (CP.6). As with Mac OS 9’s Labels,
Labels X changes icon color, has user-configurable
colors and names, and adds an optional Label col-
umn to List View windows.

STEP 6: BRING BACK WINDOWSHADE

Mac OS 9 had a built-in feature called WindowShade.
By double-clicking the title bar of any window, you
could “roll up” the contents of the window so that
only the title bar showed. This feature was very useful
for times when lots of windows were open and you
needed to reduce screen clutter without closing win-
dows.

In Mac OS X, Apple wants you to use the yellow
Minimize button to shrink windows into the Dock if
you need to get them out of the way temporarily. The
problem with minimizing windows to the Dock is
that you can’t see the window name unless you high-
light the Dock icon. Although the Dock does display
a thumbnail, picking out the window you want can
be hard if your Dock icons are hidden or very small
(or if your window contents aren’t easily recognizable
at postage-stamp size).

 Chapter 3 Customizing Mac OS X

■ To put your scroll arrows back where they
belong, open System Preferences and click the
General icon. In the middle section, you’ll see
Place scroll arrows; select the radio button next
to At top and bottom, as shown in Figure 17.7.

STEP 4: MAKE FOLDERS OPEN IN THEIR
OWN WINDOWS

By default, every time you double-click a folder icon
inside a window, the contents of the new folder replace
the previous contents of the window — without open-
ing a new folder. This keeps your screen from becom-
ing crowded with lots of extra windows, but it can be
disorienting and confusing if you’re used to opening
a new window with every new folder.

■ To make all folders open in windows of their
own, choose Preferences from the Finder’s Finder
menu and check the box next to Always open
folders in a new window (see Figure 17.8).

.

03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 112



Luckily, Unsanity (www.unsanity.com) — the
same folks who created FruitMenu and Labels X —
have yet another $10 shareware program called
WindowShade X that restores WindowShade func-
tionality to Mac OS X.

■ To bring back WindowShade functionality,
download WindowShade X from the preceding
URL, double-click its installer icon, and follow 
the on-screen instructions. Figure 17.10 shows
WindowShade X in action. In addition to rolling
up windows, it can also make them transparent
(to a user-selectable degree) among many other
features. It’s one of my very favorite Mac OS X
interface enhancements. Check it out!

Restoring “Missing” Classic Features to Mac OS X 

STEP 7: PUT THE TRASH BACK ON THE
DESKTOP

Do you miss having a Trash icon on your desktop?
Although a lot of third-party utilities you can down-
load will put your Trash back on your desktop, you
can also do it yourself very quickly and easily.

.

.

.

03 539116 Ch03.qxd  3/25/03  10:30 AM  Page 113



change until you click it. In addition, you cannot
use the fake Trash icon to eject removable media.
However, it’s still not bad for five minutes and no
money.

 Chapter 3 Customizing Mac OS X

■ To put your own Trash icon on the desktop, flip
back to Technique 10 and follow the directions in
Step 4.
■ Instead of putting your new Trash icon on a
toolbar, move it to the bottom-right corner of the
screen — where nature intended it to be (see
Figure 17.11).
■ To try out your new desktop Trash icon, drag a
file onto it, then click the Trash icon in the Dock
to confirm that the file was moved there.
Remember that your fake Trash icon does not
change to show that it has files in it, and even the
real Trash icon in the dock might not reflect the .
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